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1 UVOD 

3D modeliranje ustvarja matematično predstavo 3D objektov, stvarnosti. Uporabniki si pri 

tem pomagajo z različnimi namenskimi programskimi opremami, kot sta Maya, Google 

SketchUp idr. Da bi predstavili fotorealistični 3D model fizične stvarnosti, tudi s teksturami, 

lahko uporabimo fotogrametrične metode, s katerimi lahko iz fotografij izdelamo 3D model. 

Temu v tuji literaturi pravijo 'Image-based Modelling', torej modeliranje na osnovi slik. Glavni 

cilj takšnega pristopa je, da se tretja razsežnost ustvari iz fotografij z uporabo računalniškega 

vida, preko postopkov prepoznavanja, vrednotenja in analize informacij (Long, 2010). 

 

Popolna samodejna rekonstrukcija 3D modela objekta opazovanja iz nabora digitalnih 

fotografij, ki jih uporabnik posname sam, je kot »sveti gral« računalniškega vida. Še vedno se 

zdi, da je samodejno pridobivanje 3D modelov, kljub razvoju algoritmov, novih vpogledov v 

slikovno ujemanje in kalibracije fotoaparatov, težko dosegljivo. Na drugi strani pa dostopnost 

digitalnih nizkocenovnih fotoaparatov in sama privlačnost 3D vizualizacije poudarjajo potrebo 

po programskih orodjih, sposobnih ustvariti 3D model na osnovi digitalnih slik. Fotogrametrija 

je z razvojem računalniške tehnologije in naprednih računalniških algoritmov za obdelavo slik 

v zadnjem obdobju doživela pravi razcvet. Postopki postajajo vse hitrejši, programska 

oprema pa vedno bolj kompleksna (Mach, 2009).  

Velik napredek so doživela programska orodja, ki omogočajo pridobivanje prostorskih 

podatkov iz niza fotografij, posnetih pod različnimi zornimi koti. 3D modeli in natančne 

rekonstrukcije stvarnosti se lahko uporabljajo za dokumentiranje zgodovinskih artefaktov 

(dokumentiranje kulturne dediščine), izdelavo modelov stavb, v gradbenem inženirstvu, 

forenziki (npr. rekonstrukcija avtomobilske nesreče), v rudnikih idr. 

Iz pestrega nabora programskih orodij, ki so danes dostopna na trgu, smo si za magistrsko 

nalogo izbrali program Insight3D, da bi ga preizkusili, ker z njim še nimamo praktičnih 

izkušenj. Program Insight3D je odprtokodni program, ki je bil ustvarjen v sklopu diplomskega 

dela Lukasa Macha s Fakultete za matematiko in fiziko, Charles Univerze v Pragi. Program 

je bil izdelan z namenom čim večje samodejnosti ročnih postopkov in s tem lažje izdelave 3D 

modelov.  

Predstavitev 3D modelov objektov se po kakovosti oziroma vključevanju podrobnosti deli 

glede na stopnjo posploševanja detajlov oziroma glede na ločljivost objektov (LOD – level of 

detail) (Kolbe, 2008). Prosti standard CityGML ki je namenjen izmenjavi in modeliranju 3D 

modelov definira pet ravni razpoznavnosti prikazovanja 3D modelov stavb, označenih od 

LOD0 do LOD4. V prvi ravni (LOD0) so stavbe ponazorjene zgolj s tlorisom stavb, druga 

raven prikazuje stavbe s tlorisom in podano višino, stavbe tako tvorijo bloki osnovnih 3D 



2                                           Natlačen, D. 2015. Uporaba programa Insight3D za izdelavo 3D modela stavbe.                          
                                  Mag. d. Ljubljana, UL FGG, Magistrski študijski program Geodezija in geoinformatika. 

     

 

geometrijskih teles. Tretja raven (LOD2) doda 3D modelom obliko strehe, detajlno obliko 

sten ter tematsko opredeljene fasade. V četrti ravni podrobnosti (LOD3) se podrobneje 

prikažejo streha, stene in manjši detajli, kot so vrata, okna, zunanja stopnišča, dimniki, 

balkoni idr., v peti ravni podrobnosti (LOD4) pa se poleg zunanjosti stavb podrobno ponazori 

tudi notranjost objekta (Open Geospatial Consortium, 2012).   

Magistrska naloga je razdeljena v sedem poglavij. V uvodu so predstavljeni cilji in hipoteze 

naloge, ter načrt izvedbe in opis predvidene metodologije. Sledi drugo poglavje s 

predstavitvijo objekta obdelave, v tretjem poglavju so predstavljene teoretične osnove, ki 

bodo pripomogle k razumevanju teme magistrske naloge. V četrtem poglavju je 

predstavljena izvedba fotogrametričnih in klasičnih meritev, to je uporabljen instrumentarij, 

programska orodja, metodologija in načrt fotografiranja. V petem poglavju je opisan postopek 

izdelave 3D modela v programu Insight3D, opis težav programa, in pa primerjava z drugo 

programsko opremo. V šestem poglavju je opisana primerjava fotogrametričnega modela s 

klasičnimi meritvami, v sedmem pa povzeti rezultati in ugotovitve. V zaključku magistrske 

naloge so navedeni viri. 

 

1.1 Predstavitev stanja na področju teme magistrske naloge  

Na trgu je več komercialnih rešitev, kot so Autodesk-ov ImageModeler (Autodesk 

ImageModeler, 2009) in PhotoModeler, produkt Eos Systems (PhotoModeler, 2014). 

Programa omogočata določanje gostega oblaka točk iz posnetih fotografij in modeliranje le 

tega (Mach, 2009). Na slovenskem trgu so v podjetju Modri planet razvili podoben program 

3Dsurvey, ki na podlagi algoritmov računalniškega vida iz fotografij izračuna 3D koordinate 

objektnih točk in v dodatku omogoča tudi izdelavo ortofota (Modri planet, 2014). Na trgu 

obstajajo še druga primerljiva programska orodja – Pix4D (Pix4D, 2014), Dronemapper 

(Dronemapper, 2014), PhotoScan (Agisoft PhotoScan, 2014), Smart3Dcapture, ki ga je razvil 

Acute3D (Acute3D, 2015), Kodak Digital Science - Dimension Software (Kodak, 2015), 

Canoma (Canoma, 2001) idr.  

Nadalje je Evropska unija v enem od projektov razvila ARC 3D (3D-COFORM, 2012), ki 

uporabnikom omogoča, da preko spletnega vmesnika naložijo fotografije na spletni strežnik. 

Rezultat samodejnih izračunov iz oblaka točk je iz posnetih fotografij zmodelirano okolje. 

Nadaljnje urejevanje, pregledovanje, analiziranje 3D modelov je možno v sorodnem prosto 

dostopnem programu MeshLab (3D-COFORM, 2012). Po istem principu deluje tudi program 

Hypr3D (podjetja Viztu Technologies). Poznamo še nekatere druge sorodne sisteme – npr. 

Autodeskov 123 Catch in Insight3D, ki lahko 3D model tudi oblepi s teksturami (Mach, 2014). 
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Na spletu je mogoče zaslediti še druga programska orodja, ki se dobijo proti plačilu. 

Autodesk predstavlja RECAP 360, družba Triayaam Neitrea 3D Pro, Hippolyte Mounier je 

razvil PhotoSculpt, ki ne izdela merskih 3D modelov ... 

 

Vsem tem programskim orodjem je skupno, da po principih računalniškega vida ustvarjajo 

trirazsežno okolje. Najprej iz množice fotografij, posnetih pod različnimi zornimi koti, izdelajo 

3D oblak točk. Določitev medsebojnega položaja posnetkov poteka samodejno, odvisno 

predvsem od sposobnosti prepoznavanja homolognih značilnih točk na fotografijah. V ta 

namen se največkrat uporabljata točkovna postopka slikovnega ujemanja - SIFT (Scale 

invariant feature transform) ali SURF (Speeded-up robust features). Zaradi velikega števila 

homolognih značilnih točk na fotografijah, temelji izračun notranjih in zunanjih parametrov 

posnetka na izravnavi po metodi najmanjših kvadratov. Postopek izračuna fotogrametričnega 

3D oblaka točk je prva faza v postopku modeliranja, sledi izgradnja 3D modela in 

teksturiranje (Vidmar, 2014).  

 

1.2. Cilji naloge 

Glavni cilji magistrske naloge so spoznati se s programom Insight3D, izdelati 3D model 

izbrane stavbe z nemerskim nizkocenovnim fotoaparatom in ga primerjati s terenskimi 

meritvami. Opisali bomo potek izdelave 3D modela v programu Insight3D po korakih. Cilj je 

izdelava 3D modela stavbe četrte ravni podrobnosti oziroma prepoznavnosti (LOD3), od 

skupno petih, po standardu CityGML (Škrlec, 2013), torej bodo podrobnejše prikazane oblike 

strehe, stene, lahko pa tudi manjši detajli, kot so vrat, okna, dimniki … Obravnavani program 

bomo primerjali z nekaterimi drugimi sorodnimi programi, na osnovi informacij iz literature. 

V nalogi izhajamo iz naslednje predpostavke in cilja: 

1. S programom Insight3D je možna izdelava 3D modela zunanjosti stavbe v ravni 

podrobnosti LOD3 po standardu CityGML (Open Geospatial Consortium, 2012). 

2. Ocenili bomo relativno geometrično točnost izdelanega 3D modela, tako da bomo 

primerjali izbrane dolžine med detajli na objektu, določene s terenskimi meritvami, z 

izmerjenimi dolžinami na izdelanem modelu. 
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1.3. Načrt izvedbe in opis predvidene metodologije 

V magistrski nalogi bomo izdelali 3D model J'kopinovega senika v Škocjanu z odprtokodnim 

programom Insight3D. Program deluje na podlagi slikovnega ujemanja in je eden izmed 

množice programov, ki so dostopni na internetu in delujejo po podobnih principih. Program 

orientira posnetke v prostoru, izračuna 3D oblak točk in izdela 3D model. Izdelan 3D model 

je rezultat sosledja več korakov: fotografiranja objekta, uvoza fotografij v program, kalibracije 

fotoaparata, izračuna položaja točk -> 3D oblaka točk, 3D modeliranja in lepljenja tekstur na 

model.  

Izbran objekt je J'kopinov senik v Škocjanu, ki smo ga fotografirali z nemerskim 

fotoaparatom. J'kopinov senik leži na vzpetini sredi Krajinskega parka Škocjanske jame. 

Za izvedbo naloge opravili naslednje aktivnosti: 

1. Pripravili bomo ustrezen plan fotografiranja in ga izvedli na terenu. 

2. Opisali bomo postopek izdelave 3D modela izbranega objekta v programu Insight3D. 

3. Analizirali bomo geometrično točnost izdelanega 3D modela, tako da bomo 

fotogrametrični model primerjali s klasičnimi geodetskimi meritvami na objektu in 

določili odstopanje med fotogrametrično in geodetsko izmerjenimi kontrolnimi 

dolžinami. 
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2 OBJEKT OBDELAVE  

Za izdelavo 3D modela smo si izbrali J'kopinov skedenj, sicer kulturni spomenik v sklopu 

Krajinskega parka Škocjanske jame. Skedenj, ki je v preteklosti služil kot pomožni 

gospodarski objekt J'kopinove domačije, stoji pred strnjenim naseljem Škocjan, v bližini njiv 

in travnikov. Podatki iz katastra pričajo, da je objekt stal že pred letom 1819 in se v tem času 

ni spremenil. Skedenj je enocelični objekt s pravokotnim tlorisom, pokrit z rženo slamo, 

temena stranskih kamnitih zidov pa so pokrita s skrlami. Danes je v skednju etnografska 

zbirka, v kateri je predstavljen postopek obdelovanja zemlje, pridobivanja žita in njegovo 

uporabo v dobi, ko se je oralo z živino (Občina Divača, 2015). Na sliki 1 je v rdečem krogu 

prikazana makro lokacija Škocjana, na sliki 2 pa J'kopinov skedenj. 

 

Slika 1: Makro lokacija J'kopinovga skednja (Vir: Google maps). 

 

Slika 2: J'kopinov skedenj (Kranjc, 2015). 
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3 TEORETIČNE OSNOVE 

 

3.1 Splošno o fotogrametričnem zajemu podatkov  

Na področju 3D rekonstrukcije objektov iz fotografij delujeta dve znanstveni vedi – 

fotogrametrija in računalniški vid (Štuhec, 2012). 

Fotogrametrija je znanost o določitvi lokacije in oblike objekta iz fotografij. V 90. letih 

prejšnjega stoletja je imel na njen razvoj velik vpliv digitalni zapis podatkov, rezultat tega je 

prenos algoritmov in konceptov računalniškega vida v fotogrametrične postopke. Tako lahko 

programska oprema samodejno prepozna, poveže in preoblikuje značilnosti upodobljenih 

objektov na fotografijah v 3D elemente v objektnem prostoru (Štuhec, 2012). 

Razvoj računalniškega vida sega v 70. leta prejšnjega stoletja, s težnjo dati računalniku 

'človeški' vid, ter tako povrniti tretjo dimenzijo iz fotografij. Z algoritmi računalniškega vida je 

mogoče iz dveh fotografij določiti prostorsko lego točke in prostorsko lego fotoaparata. 

Značilnost algoritmov računalniškega vida v primerjavi s fotogrametričnimi je, da za izdelavo 

3D modela ne potrebujemo podatkov o parametrih notranje orientacije fotoaparata ter lege in 

orientacije fotoaparata v času zajema fotografij. Postopek določevanja gostega oblaka točk iz 

fotografij poznamo pod izrazom »Structure-from-motion (v nadaljevanju SfM), saj omogoča 

izračun relativne projekcijske geometrije (Štuhec, 2012). 

Povezovanje bližnjeslikovne fotogrametrije in računalniškega vida je v zadnjem desetletju 

prevzelo vodilno vlogo pri 3D modeliranju objektov. Razvoj algoritmov na področju 

računalniškega vida, nižje cene in boljša kakovost digitalnih fotoaparatov ter algoritmi za 

kalibracijo nemerskih fotoaparatov so omogočil kakovostno modeliranje objektov na osnovi 

prekrivajočih se fotografij. 

Fotogrametrični postopek SfM sicer deluje po enakih načelih kot stereo fotogrametrija, le da 

omogoči 3D modeliranje na podlagi večjega števila prekrivajočih se fotografij, posnetih pod 

različnimi zornimi koti (Westoby in sod, 2012). 

 

3.1.1 Postopek »Structure-from-motion« (SfM)  

Postopek SfM, razvit v 90. letih prejšnjega stoletja, je tesno povezan z razvojem 

računalniškega vida in algoritmi samodejnega prepoznavanja slikovnih značilk.  
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Slikovna značilka (ang. image feature), kratko značilka, je del fotografije, ki se v 

računalniškem vidu uporablja za potrebe razpoznavanja objektov, okolja, sledenje gibanja 

idr. Značilka je lahko enostavna, na primer značilna točka, oglišče, rob idr. ali kompleksna 

(objekti, krivulja idr.) struktura na fotografiji (Šajn, 2007).  

Na podlagi postopka SfM za določitev relativne geometrije objekta ter relativnega položaja in 

orientacije fotoaparata pri fotografiranju ne potrebujemo točk s poznanimi 3D koordinatami, 

ampak se ti parametri izračunajo samodejno, s postopkom izravnave, ki temelji na veznih 

točkah na perspektivno različnih posnetkih (Westoby in sod, 2012). 

 

 

Slika 3: Princip postopka SfM (Westoby in sod, 2012: str 301). 

 

Na sliki 3 je predstavljen pristop postopka SfM, ki na podlagi velikega števila prekrivajočih se 

fotografij, posnetih pod različnimi zornimi koti, izvede postopek slikovnega ujemanja, 

kalibracijo in 3D modeliranje. 

Kalibracija fotoaparata in medsebojni položaj fotografij se izračunajo na osnovi samodejnega 

prepoznavanja in ujemanja značilnih točk na večjem številu fotografij.  

Za razliko od klasične fotogrametrije je 3D oblak točk, določen s postopkom SfM, izdelan v 

relativnem lokalnem koordinatnem sistemu, ki ga moramo naknadno transformirati v 

absolutni objektni koordinatni sistem, torej določiti rotacije modela ter merilo. To storimo z 

uporabo prostorske podobnostne transformacije, na podlagi ustreznega števila oslonilnih 
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točk, s poznanimi koordinatnimi v absolutnem objektnem koordinatnem sistemu (Westoby in 

sod., 2012). 

 

3.1.1.1  Potek postopka SfM  

Postopek SfM predstavljajo trije koraki, prikazani na sliki 4. 

 

 

Slika 4: Potek postopka SfM. 
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3.1.1.1.1 Fotografiranje in prepoznavanje značilnih točk 

Glavni problem, ki ga obravnava postopek SfM, je določitev 3D položaja značilnih točk, 

prepoznanih na večjem številu fotografij, posnetih pod različnimi zornimi koti. Najpogostejši 

algoritem slikovnega ujemanja je točkovni postopek 'Scale invariant Feature Transform' (v 

nadaljevanju SIFT), ki vsaki značilni točki pripiše edinstven deskriptor, ki ga uporabi pri 

primerjavi značilnih točk na različnih fotografijah (Lowe, 1999). 

 

3.1.1.1.2 Določitev 3D oblaka točk 

Izračun notranjih in zunanjih parametrov fotografije temelji na podlagi izravnave bloka 

snopov velikega števila homolognih značilnih točk na različnih fotografijah. S tem se izboljša 

natančnost določitve položajev posnetkov in se izračunajo kalibracijski parametri fotoaparata. 

Izravnava večinoma temelji na nelinearni metodi najmanjših kvadratov (Remondino in sod., 

2012). S postopkom triangulacije se naknadno izračuna 3D oblak točk v relativnem 

koordinatnem sistemu (Westoby in sod., 2012). 

 

3.1.1.1.3 Naknadna obdelava 

Transformacijo iz relativnega lokalnega koordinatnega sistema v absolutni objektni 

koordinatni sistem zagotovimo s poznanimi koordinatami istih točk v 3D oblaku točk in 

absolutnem koordinatnem sistemu (Westoby in sod., 2012). 

 

 

3.1.2 Algoritem SIFT 

Glavni postopek računalniškega vida je SfM, ki temelji na slikovnem ujemanju. Obstajajo 

različni algoritmi slikovnega ujemanja, kot na primer: 

 SIFT (Scale-invariant feature transform) (Lowe, 1999), 

 SURF (Speeded-up robust features) (Bay, Tuytelaars, Van Gool, 2007), 

 MSER (Maximally stable extremal regions) (Donoser, Bischof, 2006), 

 MSCR (Maximally stable color regions) (Forssen, 2007) idr., 

ki omogočajo samodejno prepoznavanje značilnih točk na različnih slikah, kot je prikazano 

na sliki 5 (Mach, 2009).  
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Slika 5: Algoritem SIFT (Mach, 2009). 

 

V splošnem navedeni algoritmi prepoznajo značilne točke na fotografijah, kot so vogali, 

svetle točke, jim pripišejo deskriptorje, to je vektorje značilnih točk, ki opisujejo del slike 

(Mach, 2009). 

V postopku slikovnega ujemanja je SIFT eden izmed najbolj razširjenih algoritmov. Za ta 

algoritem je značilno, da prepoznane značilne točke s pripisanimi deskriptorji na referenčni 

fotografiji shrani v bazo. Značilne točke naslednje fotografije primerja z bazo referenčne 

fotografije in izračuna evklidsko normo razlike deskriptorjev ter s tem določi najprimernejšega 

kandidata vsaki značilni točki. Za par izbere tisti značilni točki, ki sta si najbolj podobni 

oziroma ima razlika deskriptorjev najmanjšo normo med vsemi značilnimi točkami (Lowe, 

2004).  

SIFT omogoča dobro kalibracijo fotoaparata, saj daje dobre rezultate ne glede na orientacijo 

fotografij (Mach, 2009). Algoritem namreč omogoča zaznavanje homolognih značilnih točk 

neodvisno od razlik v merilu, zasukih in premikih fotografij, delno je tudi neodvisen od 

osvetlitve in šumov na fotografijah ter drugih popačenj (Lowe, 2004). Na sliki 6 so 

prepoznane značilne točke z algoritmom SIFT. 
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Slika 6: Značilne točke prepoznane z algoritmom SIFT (Mach, 2009). 

 

Algoritem SIFT je namenjen prileganju fotografij istega objekta zajetega iz različnih 

perspektiv, za določanje značilnih točk pa išče ekstreme preko različnih ločljivosti fotografij 

(Šajn, 2007). 

Algoritem na začetku progresivno gladi slike s pomočjo Gaussovega filtra, kjer se deviacija 

spreminja od σ do 2 * σ. Prikaz rezultata progresivnega glajenja oziroma tako imenovanega 

kaskadnega filtriranja je prikazan na sliki 7. 

 

 

Slika 7: Originalna (skrajno levo) in glajene fotografije (Mach, 2009). 

 

V naslednjem koraku se te glajene slike odštevajo od njihovih neposrednih sosedov (ang. 

difference of Gaussian), rezultat razlike neposrednih sosedov je viden na sliki 8. 
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Slika 8: Rezultat razlike dveh sosednjih fotografij v prostoru meril (ang. scale-space) (Mach, 2009). 

 

Glajenje je računsko manj zahtevno od spreminjanja ločljivosti, tako da se ta algoritem 

predlaga zaradi zmanjšanja računske kompleksnosti pri pomanjšavi slik, saj obstaja linearna 

povezava med glajenjem slike s faktorjem σ in zmanjševanjem njene ločljivosti (Šajn, 2007). 

 

Algoritem SIFT sestavljajo štirje koraki (Lowe, 2004): 

  »scale-space extrema detection« - postopek iskanja značilnih točk, 

 »keypoint localization« - postopek prepoznavanja in umestitve značilnih točk,  

 »orientation assignment« - določitev orientacije značilnih točk in 

 »keypoint descriptor« - izračun deskriptorja značilnih točk. 

 

3.1.2.1       Scale-space extrema detection - postopek iskanja značilnih točk 

Postopek iskanja značilnih točk poteka preko detekcije ekstremov med različnimi ločljivostmi 

fotografij. Na vsaki glajeni fotografiji se primerjajo točkovni elementi z osmimi sosednjimi 

točkovnimi elementi na isti fotografiji in devetimi točkovnimi elementi na sosednjih 

fotografijah. Izberemo tiste, ki od vseh sosedov odstopajo (Šajn, 2007). 
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3.1.2.2      Keypoint localization - postopek prepoznavanja in umestitve značilnih točk 

V tem koraku se značilne točke določijo na osnovi najdenih ekstremov s pomočjo mere 

stabilnosti (Šajn, 2007). 

 

3.1.2.3       Orientation assignment - določitev orientacije značilnih točk  

Orientacijo določimo z uporabo bilinearne interpolacije tako, da za vsako značilno točko 

izračunamo smerne odvode v okolici 16 x 16 (Šajn, 2007). 

 

3.1.2.4       Keypoint descriptor - deskriptor značilnih točk. 

Značilno točko, ki pripada določeni ločljivosti, opišemo s 128-dimenzionalnim vektorjem na 

podlagi izračunanih smernih odvodov (Šajn, 2007). 

 

Slika 9: Deskriptor iz slikovnih gradientov v okolici značilne točke (Hurrelmann, 2015). 

 

Šestnajst podobmočij in osem smeri, to je vektor z 128 elementi in je deskriptor značilne 

točke. Na sliki 9 prikazan kot 'keypoint descriptor'. 

 

3.2 Osnove kalibracije 

Fotoaparat je osnovno orodje fotogrametrije. Glede na uporabljeno tehnologijo jih delimo na 

analogne in digitalne, z vidika uporabe pa na merske in nemerske fotoaparate. Medtem, ko 

imajo merski fotoaparati laboratorijsko določene vrednosti notranje orientacije, ki so stabilni 
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in robustni, imajo nemerski fotoaparati spremenljivo optiko ter nestabilne in neznane 

parametre notranje orientacije (Cigelšek, 2012). 

Parametri notranje orientacije, to so konstanta fotoaparata, položaj glavne točke na sliki in 

distorzija objektiva, opisujejo glavne geometrijske lastnosti idealizirane preslikave centralne 

projekcije, obenem pa definirajo merski slikovni koordinatni sistem. S centralno projekcijo 

matematično opišemo odnose med fotografiranim objektom, fotoaparatom in sliko. 

Preslikava objekta v centralni projekciji se izvaja po zakonih projektivne geometrije, torej je 

pomembno, da objektna točka, projekcijski center in slikovna točka ležijo na isti premici 

(Cigelšek, 2012).  

Poleg določitve parametrov notranje orientacije, je potrebno določiti tudi optično distorzijo. 

Približek distorzije lahko zmodeliramo, torej opišemo matematično, če poznamo koeficiente 

distorzije, ki jih določimo s postopkom kalibracije fotoaparata. Največkrat uporabljena metoda 

kalibracije je metoda s kalibracijskim poljem – mrežo točk z znanimi koordinatami. Na podlagi 

znanih dejanskih koordinat točk kalibracijskega polja in na zajetih slikah izmerjenih koordinat 

točk istega polja izračunamo koeficiente distorzije. Distorzijo opišemo z enačbo (1), to je s 

parametri distorzije kc, koordinatami 'popačene' točke [xd yd], koordinate 'nepopačene' točke 

[x y], in r2=x2+y2 (Mrovlje, 2009). Od uporabljenih parametrov in modela je odvisno kako 

dober približek dejanskega stanja nastane (Clarke in sod., 1998).  

 

(1) 

Merski fotoaparati imajo parametre notranje orientacije definirane pred odhodom na teren, pri 

nemerskih moramo za to poskrbeti sočasno s fotografiranjem objekta na terenu. Ena od 

možnosti je, da kalibracijo opravimo na podlagi perspektivno različnih posnetkov objekta in 

izračun notranje orientacije fotoaparata vključimo v izravnavo bloka snopov (ang. bundle 

block adjustment) (Cigelšek, 2012). 

 

3.3 Pol samodejni pristop programa Insight3D k izdelavi 3D modela 

V magistrski nalogi bomo spoznali delovanje programa Insight3D, ki deluje na podlagi pol 

samodejnega pristopa izdelave 3D modela. V prvi fazi omogoča samodejno prepoznavanje 

homolognih značilnih točk na zajetih fotografijah in kalibracijo, v drugi fazi pa ročno 

identifikacijo in prepoznavanje slikovnih točk ter modeliranje.  
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Princip programa je čim hitrejša izgradnja 3D modela. Zahteven in dolgotrajen postopek je 

postopek kalibracije, njegova točnost pa pripomore h kakovostni izgradnji 3D modela. 

Najpomembnejša koraka pri kalibraciji sta samodejno prepoznavanje homolognih značilnih 

točk in pa prilagoditev algoritmov kalibracije v smislu robustnosti, saj se pri samodejnem 

prepoznavanju homolognih značilnih točk pojavijo grobe napake, ki jih mora program v 

postopku kalibracije prepoznati (Mach, 2009). 

 

3.3.1    Slikovno prepoznavanje v programu Insight3D 

Insight3D deluje na podlagi dobro definiranega in preizkušenega prej opisanega algoritma 

SIFT. Prepoznanim značilnim točkam je dodeljen 128 dimenzion alni vektor, deskriptor, ki ga 

primerja z deskriptorji naslednje fotografije. Iskanje prepoznanih značilnih točk na fotografijah 

predstavlja dolgotrajne izračune, sploh, če se primerja vsak možen par značilnih točk (Mach, 

2009). 

 

3.3.2      Kalibracija fotoaparata v programu Insight3D 

Po končanem slikovnem ujemanju sledi kalibracija fotoaparata.  

Program Insight3D zgradi rešitev za par fotografij z izračunom projekcijske matrike, ki 

vsebuje parametre zunanje orientacije fotografije (poljubno merilo, translacija, rotacija), z 

uporabo fundamentalne matrike. Fundamentalna matrika opisuje preslikavo, ki povezuje 

točke na dveh fotografijah, ki pripadata isti točki v prostoru.  

Fotografije razporedi glede na število homolognih značilnih točk v padajočem vrstnem redu, 

nato pa naključno izbere par fotografij in oceni fundamentalno matriko z uporabo linearnega 

algoritma.  

Za zagotavljanje robustnosti operacije, uporabi algoritem RANSAC, ki izloči morebitne šume 

oziroma napačno prepoznane homologne značilne točke na fotografijah. 

Na koncu določi položaj značilne točke vidne na obeh fotografijah s triangulacijo, na podlagi 

najmanj dveh znanih projekcij te točke. Predpostavimo, da imamo dane projekcijske matrike 

P1, P2, … , Pn in koordinate x1, x2, … , xn projekcije te točke z vsake fotografije. Namen je 

najti tako točko X v P3 prostoru, ki minimizirala vsoto kvadratov razdalje med projekcijama (2) 

(Mach, 2009): 
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min
𝑋

∑ 𝑑

𝑖=1…𝑛

(𝑃𝑖𝑋, 𝑥𝑖)2 

(2) 

 

V postopku kalibracije se poleg klasičnih parametrov notranje orientacije (goriščna razdalja, 

radialna distorzija idr.) izračunajo tudi relativni položaji fotoaparata glede na izračunan oblak 

točk (Mach, 2009). 
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4 OPIS TERENSKE IZVEDBE FOTOGRAMETRIČNIH IN KLASIČNIH MERITEV  

 

4.1. Uporabljen instrumentarij in programska orodja 

Za izdelavo magistrske naloge smo uporabili naslednji instrumentarij: 

 fotoaparat Nikon D70 in objektiv AF-S DX Zoom-Nikkor, 

 elektronski tahimeter Leica TCRP 1203+ in stativ, 

 trasirko s prizmo, 

 GPS anteno in 

 merski trak. 

In naslednja programska orodja: 

 Insight3D, 

 MeshLab in 

 Adobe Photoshop. 

 

4.1.1. Fotoaparat Nikon D70 

Za fotografiranje objekta smo uporabili nemerski digitalni zrcalno-refleksni fotoaparat Nikon 

D70, z objektivom AF-S DX Zoom-Nikkor 18-70 mm f/3.5~4.5G IF ED, kot ga vidimo na sliki 

10. Lastnosti uporabljenega fotoaparata so navedene v preglednici 1 (Nikon, 2015). 

 

Preglednica 1: Lastnosti digitalnega fotoaparata Nikon D70 in objektiva AF-S DX Zoom-Nikkor (Nikon, 
2015). 

Lastnosti Vrednosti 

Število vseh pikslov 6.24 MP 

Svetlobno tipalo CCD 

Velikost tipala 23.7 mm x 15.6 mm 

Ločljivost 3008 x 2000 

Občutljivost tipala ISO 200 - 1600 

Goriščna razdalja 18 – 70 mm 

Zaslonka 3.5-29 

Čas zaklopa 1/8000 – 30 sek 
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Slika 10: Fotoaparat Nikon D70 (Nikon, 2015). 

 

4.1.2. Leica TCRP 1203+ 

Elektronski tahimeter Leica TCRP 1203+ je produkt Švicarskega podjetja Leica. Sodi med 

sodobne in zmogljive tahimetre serije TPS1200, ki omogočajo poleg merjenja kotov in dolžin 

ter dolžin brez reflektorja, tudi samodejno prepoznavanje in sledenje reflektorja, samodejno 

natančno viziranje, daljinsko vodenje idr. (Gajšek, 2007). V preglednici 2 so navedene 

nekatere lastnosti uporabljenega elektronskega tahimetra. 

 

Preglednica 2: Lastnosti elektronskega tahimetra Leica TCRP 1203+ (Gajšek, 2007). 

Lastnosti Vrednosti 

Natančnost merjenja horizontalnih smeri in zenitnih razdalj 3'' (1,0 mgon) 

Natančnost merjenja dolžin z reflektorjem 2 mm + 2 ppm 

Natančnost merjenja dolžin brez reflektorja 3 mm + 2 ppm 

Natančnost kompenzatorja 1,0'' (0,3 mgon) 

Doseg z reflektorjem 3000 m 

Doseg brez reflektorja 300 m 
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4.1.3. Program Insight3D 

Po končanem terenskem fotografiranju stavbe smo delo nadaljevali na računalniku. Uporabili 

smo program Insight3D, ki je avtorsko delo Lukasa Macha. Insight3D je odprtokodni 

program, delujoč v okolju Windows ali Linux, ki je namenjen izdelavi 3D modelov iz zajetih 

fotografij. Za fotografiranje stavbe potrebujemo zgolj običajen digitalni fotoaparat. 

V programu smo delo opravili po naslednjih korakih: 

1. uvoz fotografij stavbe, 

2. samodejno prepoznavanje značilnih točk, 

3. kalibracija fotoaparata, 

4. izračun 3D oblaka točk, 

5. modeliranje, 

6. teksturiranje modela, 

7. shranjevanje in izvoz modela. 

Za nemoteno delovanja programa Insight3D smo uporabili računalnik z naslednjimi 

lastnostmi: 

 procesor Intel Core i7, 

 pomnilnik 16 GB (RAM) in 

 grafična kartica AMD Radeon HD 6700 Series. 

 

 

4.1.4. Druga programska orodja 

Naslednje programsko orodje, ki smo ga uporabili, je brezplačni, odprtokodni program 

MeshLab. MeshLab ni le pregledovalnik, je program za izdelavo, obdelavo, urejanje in 

pregledovanje oziroma analizo 3D modelov (Cignoni in sod., 2008). Program MeshLab smo 

uporabili, da smo enemu izmed 3D modelov na podlagi klasično izmerjenih oslonilnih točk 

zagotovili absolutno orientacijo, drugemu 3D modelu pa merilo, na podlagi ročno izmerjenih 

karakterističnih dolžin. 

Dodatno programsko orodje, ki smo ga uporabili, je Adobe Photoshop, produkt podjetja 

Adobe Systems. Adobe Photoshop je profesionalni računalniški program za obdelavo, 

shranjevanje, optimizacijo fotografij in drugih rastrskih grafik (Adobe Photoshop, 2015). 

Program Adobe Photoshop smo uporabili za maskiranje fotografij, ki smo jih uporabili pri 

izdelavi 3D modela. 
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4.2. Opis metodologije 

Preden smo se lotili izdelave 3D modela izbranega objekta, smo se najprej spoznali s 

programom Insight3D.  

V naslednji fazi dela je bil izbor obravnavanega objekta in ogled terena. Na podlagi velikosti 

objekta, njegove lege in priporočil glede fotografiranja iz navodil, ki so priložena programu, 

smo naredili plan snemanja. Fotografiranje je bilo potrebno izvesti tako, da je bil na vsaki 

fotografiji viden čim večji del obravnavanega objekta, fotografije so morale biti ostre, preklop 

med sosednjimi fotografijami naj bi bil čim večji, sam kot med različnimi stojišči fotografiranja 

pa čim manjši, zaželeno je, da med 15° in 25°. Nadalje je bilo pomembno, da je bilo na 

obravnavanem objektu čim več detajla in tekstur, saj je na monotonih stenah premalo 

detajlov za dobro prepoznavanje značilnih točk, zaradi pravilne določitve goriščne razdalje se 

je bilo potrebno izogniti fotografiranju samo ene ravnine v prostoru, prepovedano je bilo 

obrezovanje fotografij ter priporočeno upoštevati, da je vsak detajl viden na vsaj treh slikah 

(Mach, 2009).  

Po končanem fotografiranju je sledil pregled fotografij. Glede na to, da program Insight3D ne 

omogoča maskiranja fotografij, smo zato izbrali program Adobe Photoshop in maskirali del 

fotografij. Zanimal nas je zgolj obravnavani objekt, s tem pa smo se izognili okolici, ki bi nam 

kasneje lahko povzročala težave pri prepoznavi homolognih značilnih točk. Za maskiranje 

fotografij smo se odločili šele na podlagi težav, ki smo jih imeli pri obdelavi podatkov v 

programu, kljub temu, da za to ni priporočil v navodilih.  

Prvi korak v programu Insight3D je bilo prepoznavanje in ujemanje značilnih točk. To je 

ključen korak za uspešnost kalibracije. Po končani kalibraciji je sledilo ročno označevanje 

identičnih/homolognih točk (ang. user vertices) na čim večjem številu fotografij ter njihovo 

povezovanje v ploskve in modeliranje objekta. Ko smo imeli model končan, je sledilo 

teksturiranje zmodeliranih ploskev. Končanemu modelu je bilo potrebno zagotoviti še merilo. 

Z nekaj karakterističnimi razdaljami smo to storili v programu MeshLab. Na koncu smo 

geometrično točnost 3D izdelanega modela preverili z geodetskimi meritvami kontrolnih 

dolžin. Shematski prikaz posameznih faz izdelave 3D modela stavbe je prikazan na sliki 11. 
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Slika 11: Shematski prikaz izdelave 3D modela. 

 

 

4.3 Načrt in izvedba snemanja 

Namen magistrske naloge je bil, da se spoznamo z delovanjem programa Insight3D in v 

končni fazi naredimo 3D model izbranega objekta ter izvedemo primerjavo fotogrametričnega 

izdelka s klasičnimi geodetskimi meritvami. Glede na to, da nam je bil program Insight3D 

popolnoma nepoznan, smo si za obravnavan objekt izbrali enostavno stavbo, pravokotne 

oblike, z grobimi teksturami.  
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Za fotografiranje smo uporabili nemerski fotoaparat Nikon D70, ki je na naši fakulteti na voljo 

za študijske namene, in je tudi ustrezal namenu naše naloge.  

Pri zajemu fotografij smo se držali priporočil iz navodil. Glede na lastnosti izbranega objekta, 

ki je pritličen in razmeroma majhen, smo za zajem objekta načrtovali zgolj terestrične 

fotografije. Razdalja med objektom in stojišči je bila približno 7 m. Pri fotografiranju smo 

pazili, da so bile fotografije ostre, posnete iz približno enake oddaljenosti, zaradi zaželenega 

preklopa ter kota med sosednjimi fotografijami se nismo mogli izogniti fotografiranju zgolj ene 

ravnine v prostoru, v našem primeru sprednje in zadnje fasade. Pozornost smo usmerili tudi 

na kamniti zid, ki se iz sprednje strani objekta razteza v vzhodni in zahodni smeri. Pri zajemu 

vzhodne fasade smo se morali izogniti grmovju. Za izdelavo končnega modela smo uporabili 

23 fotografij. Prikaz razporeditve obravnavanih fotografij je na sliki 12, v oranžni barvi je 

nakazan kamnit zid. 

Fotografiranje smo načrtovali na oblačen dan, da smo se čim bolj izognili sencam in 

neenakomerni osvetlitvi. 

 

Slika 12: Prikaz razporeditve zajetih fotografij. 
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5 RAČUNALNIŠKA OBDELAVA PODATKOV  

 

Najprej smo se spoznali s programom Insight3D, analizirali postopke obdelave, v drugem 

koraku pa izdelali topološko urejen 3D model izbranega objekta.  

Postopek delovanja programa Insight3D sem opisala s pomočjo navodil za uporabo 

programa - Insight3D - quick tutorial (Mach, 2009). 

 

5.1 Delovanje programa Insight3D 

Najprej namestimo program Insight3D na disk in zaženemo insight3d.exe. Slika 13 prikazuje 

uporabniški vmesnik in konzolno okno programa Insight3D. 

 

 

Slika 13: Prikaz uporabniškega vmesnika in konzolnega okna programa. 

 

Na vrhu uporabniškega vmesnika se nahaja glavni meni, z zavihki 'File', 'Edit', 'View', 

'Matching', 'Calibration', 'Modelling' in 'Image'. Na levi strani se nahajajo bližnjice, ki 

omogočajo hitrejše upravljanje programa. Ko odpremo program, se pojavi tudi konzolno 

okno, v katerem se prikazujejo podatki o delovanju progama in informacije o morebitnih 

napakah.  
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Ko zaženemo program Insight3D, se odpre prazen projekt. Naslednji korak je, da vanj 

dodamo slike. S klikom na 'File' -> 'Add image' dodamo sliko po sliko. Hitrejši način je, da 

ustvarimo datoteko z besedilom (prikazana na sliki 14), vanjo shranimo imena fotografij (v 

vsaki vrstici ime ene fotografije) in odpremo datoteko. Pomembno je, da je datoteka z 

besedilom shranjena v isti mapi kot uporabljene fotografije. Primer datoteke z besedilom je 

prikazan na spodnji sliki. 

 

 

Slika 14: Dokument z uporabljenimi fotografijami. 

 

Ko dodamo fotografije v program, se nam prva iz seznama prikaže v uporabniškem 

vmesniku programa. 

 

5.1.1 Prepoznavanje in ujemanje homolognih značilnih točk 

Ko imamo fotografije vnesene v program, lahko začnemo s postopkom prepoznavanja 

homolognih značilnih točk. To lahko storimo na dva načina, tako da primerjamo vsako 

fotografijo z vsako – vse pare ali samo sosednje fotografije (po vrsti kot smo jih vnesli v 

program) med seboj.  

Če je v projektu devet ali več fotografij, je priporočljivo, da se homologne značilne točke 

prepoznava zgolj med sosednjimi fotografijami (»Just neighbours (linear sequence)«). 

Nastavimo lahko tudi različne stopnje ločljivosti fotografij – visoko, srednjo ali nizko. Višja 

ločljivost pomeni več točk za primerjavo. 
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Postopek prepoznavanja homolognih značilnih točk traja nekaj časa. V povprečju za deset 

fotografij traja približno minuto, v tem času lahko postane program neodziven. Ko je 

postopek prepoznavanja homolognih značilnih točk končan, vidimo označene homologne 

značilne točke na fotografiji. Prikažejo se črni majhni kvadrati, ki predstavljajo značilne točke, 

uspešno prepoznane tudi na drugih fotografijah. Na sliki 15 so desno zgoraj prikazane 

fotografije, na katerih je izbrana homologna značilna točka uspešno prepoznana.  

 

 

Slika 15: Fotografije s prepoznanimi homolognimi značilnimi točkami. 

 

5.1.2 Avtokalibracija  

Naslednji korak je sama kalibracija, izračun parametrov notranje orientacije fotoaparata. V 

primeru, ko so homologne značilne točke razporejene po celotni fotografiji in je število 

pravilno prepoznanih homolognih značilnih točk veliko, s postopkom kalibracije ne bi smeli 

imeti težav.  

Postopek kalibracije izberemo v meniju 'Calibration' -> 'Automatic calibration'. Postopek 

računanja parametrov notranje orientacije fotoaparata traja nekaj trenutkov – odvisno je od 

števila fotografij. Rezultat kalibracije vidimo v pregledovalniku ('Overview mode'), to so 

piramide na sliki 16, ki predstavljajo položaj fotoaparata ob zajemu posamezne fotografije. 

Pregledovalni način 'Overview mode' izberemo v meniju 'Edit' -> 'Mode' -> 'Overview mode'. 
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Slika 16: Shematski prikaz rezultatov avtokalibracije. 

 

Na sliki 16 je v rožnato obarvana piramida, ki predstavlja položaj fotoaparata pri zajemu 

fotografije, izbrane v pregledovalniku »Shot mode«. 

V primeru, da so piramide obrnjene z osnovno ploskvijo proti navideznemu oblaku točk, bo 

3D oblak točk, ki ga izračunamo v naslednjem koraku, pravilno orientiran. 

 Po postopku kalibracije so notranja in zunanja orientacija fotoaparata določeni v relativnih 

enotah.  

 

5.1.3 3D oblak točk   

Pravilen izračun kalibracije lahko preverimo z izračunom 3D oblaka točk celotnega objekta. 

Kreiranje 3D oblaka točk dobimo v meniju 'Modelling' -> 'Triangulate all vertices'.  

V primeru, da je oblak točk deformiran, je lahko razlog v slabem prepoznavanju in ujemanju 

homolognih značilnih točk. V tem primeru uporabimo ukaz 'Modelling' -> 'Triangulate, only 

trusted', ki izračuna 3D oblak točk zgolj iz tistih ujemajočih homolognih značilnih točk, za 

katere obstaja večja verjetnost, da so pravilne.  
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3D oblak točk si lahko ogledamo v pregledovalniku 'Overview mode'. V kolikor ga želimo 

videti v realnih barvah (slika 17), uporabimo ukaz 'Image' -> 'Colorize vertices'.  

 

 
 

Slika 17: Izračunana 3D oblaka točk, na spodnji sliki je prikazan v realnih barvah. 

 

 

5.1.4 Modeliranje 

Najprej si moramo pazljivo ogledati izračunan 3D oblak točk. Če ni prišlo do napake pri 

izračunu, kar sklepamo na podlagi vizualnega pregleda 3D oblaka točk, lahko nadaljujemo z 

modeliranjem.  

Prvi korak modeliranja je označevanje slikovnih točk na različnih fotografijah, drugi korak je 

izgradnja 3D modela, povezovanje homolognih objektnih točk v ploskve. Označevanje 

slikovnih točk se izvaja interaktivno preko modula 'Shot mode'. 
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5.1.4.1  Identifikacija in označevanje slikovnih točk 

Postopek modeliranja izvedemo v načinu 'Shot mode' ('Edit' -> 'Mode' -> 'Shot mode'). Da bi 

se izognili nepreglednosti med samodejno prepoznanimi točkami, to je 3D oblakom točk, jih 

lahko začasno izklopimo z ukazom 'View' -> 'Show/Hide automatic points', saj identične 

slikovne točke na novo ustvarimo in niso del 3D oblaka točk 

Za identifikacijo slikovnih točk uporabimo orodje 'Points creator', ki se nahaja v levem delu 

uporabniškega vmesnika programa. Ista slikovna točka, detajl mora biti označen najmanj na 

dveh fotografijah. 

Kreiranje istih slikovnih točk oziroma detajlov izvedemo z levim klikom na miški. Z aktivnim 

orodjem 'Points creator' vidimo pod kurzorjem miške povečano sliko, kar nam pomaga pri 

bolj natančni določitvi detajla. S kolescem na miški povečamo in pomanjšamo fotografijo.  

Ko na fotografiji označimo vse želene slikovne točke, detajle, se s klikom na 'Next' oziroma 

'Previous' gumb, ki ležita v levem delu uporabniškega vmesnika programa, premaknemo na 

naslednjo oziroma prejšnjo fotografijo, kjer še nismo ročno označili detajlov. 

Tokrat se moramo označevanja slikovnih točk lotiti v istem vrstnem redu, kot smo se ga na 

prvi fotografiji. Kot je prikazano na sliki 18, pod kurzorjem miške opazimo detajl, ki smo ga 

kot prvega označili na prvi fotografiji, pod njim pa povečano fotografijo, ki nam pomaga pri 

bolj natančni določitvi istega detajla. 

 

 

Slika 18: Detajl, ki ga moramo naslednjega označiti. 
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Prehod med prvim detajlom in naslednjimi, ki jih moramo še označiti na fotografiji, lahko 

opravimo z gumbi na tipkovnici, opisanimi v preglednici 3. 

 

Preglednica 3: Lastnosti gumbov, ki omogočijo prehod med detajli. 

Gumb Njegova lastnost 

'Page down' Preskočimo trenutni detajl 

'Page up' Vrnemo se na prejšnji detajl 

'Home key' Pokaže prvi, še neoznačen detajl 

'End key' Dovoli označiti nov detajl 

 

Slikovne točke označimo na čim večjem številu fotografij, in s triangulacijo izračunamo njihov 

objektni položaj v meniju 'Modelling' -> 'Triangulate user vertices'. Na sliki 19 so levo 

prikazani boljše, desno pa slabše izračunani položaji objektnih točk. 

 

Slika 19: Prikaz boljšega in slabšega izračuna položaja homolognih točk. 

 

Slika 19 prikazuje natančnost izračunanih položajev objektnih točk. Natančnost predstavlja 

dolžina zelene puščice. Večja kot je dolžina, slabša je natančnost. 

V primeru, da smo se zmotili pri določevanju slikovnih točk, jih lahko izbrišemo tako, da z 

desnim klikom na miški označimo točko, ta se obarva vijolično, in izberemo v meniju 'Edit'       

->'Erase selected points'. Na enkrat lahko izberemo eno ali več slikovnih točk.  
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Če želimo izbrisati slikovno točko na vseh fotografijah, jo najprej izberemo v meniju 'Edit' -> 

'Select' -> 'Add corresponding points' in jo nato izbrišemo po istem postopku, kot eno samo. 

Ko označimo vse želene slikovne točke na vseh fotografijah in jim izračunamo položaj, si jih 

lahko ogledamo v pregledovalniku 'Overview mode'. Objektne točke so določene v 3D 

lokalnem koordinatnem sistemu. 

 

5.1.4.2  Povezovanje objektnih točk v ploskve 

Ko imamo določene objektne točke in njihov položaj v 3D lokalnem koordinatnem sistemu, jih 

povežemo v ploskve, to je zgradimo 3D model.  

Vrnemo se v način 'Shot mode' in aktiviramo orodje za kreiranje ploskev (ang. 'polygons 

creator'), v levem delu uporabniškega vmesnika programa.  

Z levim klikom na miški izberemo objektne točke in jih povežemo v želene ploskve. Ploskev, 

ki jo kreiramo in s katero upravljamo, je obarvana vijolično. Ko smo z njo zadovoljni, potrdimo 

s tipko Enter na tipkovnici in ploskev se obarva belo (slika 20). 

 

 

Slika 20: 3D model. 

 

V primeru, da bi jo želeli ponovno izbrati, in jo po možnosti izbrisati, jo določimo s klikom 

'PageDown' oziroma' PageUp' na tipkovnici. Ko se želena ploskev obarva vijolično, lahko z 

njo upravljamo. Izbrišemo jo v meniju 'Edit' -> 'Erase current polygon'. Določeno objektno 
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točko iz kreirane ploskve izločimo, če pritisnemo na tipkovnici tipko Shift in jo označimo z 

levim klikom na miški. 

Ni nam potrebno označiti iste ploskve na vseh fotografijah, kjer so vidne objektne točke. 

Dovolj je, da to storimo enkrat. 

 

5.1.5 Teksturiranje modela 

V pregledovalniku 'Overview mode' si lahko ogledamo 3D model. Če manjka kakšna izmed 

ploskev, je razlog v napačni določitvi slikovne točke in izračunanega njenega položaja. V 

takem primeru ponovimo zgoraj opisan postopek.  

Sledi še zadnji korak modeliranja, to je teksturiranje ploskev, ki je opravljen enostavno, s 

klikom na meni 'Image' -> 'Generate textures'. Na sliki 21 je prikazano nepopolno 

teksturiranje 3D modela. 

 

 

Slika 21: Nepopolno teksturiran 3D model. 

 

5.1.6 Shranjevanje in izvoz projekta 

Priporočljivo je, da projekt med samim delom večkrat shranimo. V glavnem meniju 'File' -> 

'Save project', določimo ime projektu in ga shranimo s končnico *.i3d, odpremo ga v meniju 

'File' -> 'Open project'. 
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Model lahko izvozimo v več različnih formatov, ki so zapisani v preglednici 4. 

 

Preglednica 4: Formati, ki jih lahko izvozimo oziroma uvozimo v program. 

Izvozni format Uvozni format 

VRML *.vrml RealVIZ projekt *.rzml, *.rzi 

Sandy3D ActionScript *.as Points *.txt 

RealVIZ project *.rzml, *.rzi Pointcloud *.txt 

Cameras *.txt  

Pointcloud *.txt  

 

 

5.2 Obdelava fotogrametrično zajetih podatkov in težave pri delu s programom 

Pri uporabi programa Insight3D in modeliranju objekta smo naleteli na kar nekaj težav. 

 

5.2.1  Fotografiranje objekta 

Kot prvo bi omenili fotografiranje objekta. Na prvi pogled se zdi izbran objekt enostaven za 

modeliranje, vendar nam je nekaj težav povzročalo že samo fotografiranje le tega. Iz 

sprednje strani objekta se v vzhodni in zahodni smeri razteza kamniti zid, na vzhodni strani je 

dodatno oviro predstavljalo grmovje.  

 

 Kamniti zid  

Kamniti zid je predstavljal težavo pri prepoznavanju in ujemanju značilnih točk. Izkazalo se 

je, da je potrebno pri fotografiranju objekta, kjer se stika s kamnitim zidom, le tega 

fotografirati bolj detajlno, tako, da je kamniti zid na čim večjem številu fotografij (čim večje 

prekrivanje). Tako smo zagotovili zadostno število značilnih točk po celotnem kamnitem zidu 

in uspešno kalibracijo fotoaparata. Prikaz fotografiranja kamnitega zidu je na sliki 22. 
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Slika 22: Prikaz fotografiranja kamnitega zidu. 

 

 Grmovje  

Grmovje na vzhodni stani objekta nam je preprečilo, da bi fotografirali okoli objekta z enake 

oddaljenosti in enakim kotom snemanja. Tako je bil kot med stojiščem pred in po grmovju 

večji od priporočenega. Na sliki 23 je prikaz fotografiranja objekta, glede na opisano oviro – 

grmovje. 

 

 

Slika 23: Prikaz fotografiranja objekta okoli grmovja. 

 

 

5.2.2  Slikovno ujemanje 

V fazi prepoznavanja značilnih točk so nam težave povzročali kamniti zid, detajli na fotografiji 

v okolici obravnavanega objekta in število fotografij, ki smo jih uporabili. 
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 Kamniti zid 

Kot smo že omenili, smo morali biti pri fotografiranju kamnitega zida bolj temeljiti in ga 

fotografirati z večjim preklopom med sosednjimi fotografijami. S tem smo omogočili, da je bilo 

na vsaki fotografiji dovolj značilnih točk, ki jih je program lahko primerjal z značilnimi točkami 

na drugih fotografijah. Na sliki 24 je prikazano napačno ujemanje značilnih točk. 

 

Slika 24: Prikaz napačnega ujemanja značilnih točk na kamnitem zidu. 

 

 Detajli okoli obravnavanega objekta 

Okolica obravnavanega objekta je enolična. Težava se je pokazala pri prepoznavanju 

značilnih točk in ujemanju le teh. Prišlo je do napak, ki so v naslednjem koraku otežile 

kalibracijo. Zato smo se odločili, da fotografije maskiramo, kljub temu, da program tega ne 

omogoča in v navodilih za to ni priporočil. Tako smo v programu Adobe Photoshop pobelili 

okolico obravnavanega objekta, kot je prikazano na sliki 25. 

S tem smo se izognili večjemu številu napačno povezanih značilnih točk in posledično 

pravilno izračunali parametre kalibracije fotoaparata.  
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Slika 25: Primer neobdelane in maskirane fotografije. 

 

 Število obravnavanih fotografij 

Pri večjih objektih, bolj zahtevnih oblik, je težava število fotografij. Večje kot je število 

fotografij, več je možnosti, da bi prišlo do napake pri slikovnem ujemanju in posledično pri 

izračunu notranje in zunanje orientacije fotografij. Težava je, da ne moremo preveriti, pri 

kateri fotografiji se pojavi napaka. Tako lahko zgolj ugibamo in preizkušamo različne 

kombinacije fotografij, po možnosti posnetih pod različnimi pogoji, z različnimi nastavitvami 

fotoaparata. Število fotografij vpliva tudi na hitrost obdelave podatkov in na samo stabilnost 

programa.  

 

5.2.3 Postopek kalibracije 

Pri postopku kalibracije smo naleteli na številne težave. Kot prvo se je za težavo izkazalo 

nepravilno ujemanje homolognih značilnih točk. To smo izboljšali z maskiranjem fotografij, 

preden smo jih vključili v obravnavo.  

Program Insight3D omogoča samodejno kalibracijo fotoaparata. Pogoj za uspešno izvedbo 

kalibracije je dobro ujemanje homolognih značilnih točk. Težava je v tem, da iz programa ni 

možno dobiti kalibracijskega poročila s podatki o morebitnih napakah kalibracije, natančnosti 

parametrov notranje orientacije, kakovosti fotografij idr. O uspešnosti kalibracije priča zgolj 

razporeditev ter skladna oblika piramid, ki prikazujejo položaje fotoaparata pri fotografiranju, 

tako da lahko o pravilnosti postopka sklepamo zgolj posredno. Dva primera nepravilne 

kalibracije sta prikazana na sliki 26. Sklepamo lahko, da položaji fotoaparata v času zajema 

fotografij niso bili takšni, kot jih s piramidami prikazuje slika 26. Različne oblike piramid na 

sliki 26 prikazujejo velike in neresnične spremembe parametrov notranje orientacije med 

fotografiranjem. Program ne omogoča postopnega dodajanja fotografij v projekt, saj začne 
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postopek kalibracije vedno znova. Tako ne moremo presoditi katere fotografije povzročajo 

težave. 

 

Slika 26: Dva primera nepravilne kalibracije. 

 

5.2.4 3D oblak točk 

Po postopku kalibracije sledi izračun 3D oblaka točk. Kljub uspešnemu postopku kalibracije 

se je velikokrat zgodilo, da so se piramide pri izračunu 3D oblaka točk obrnile, kot je razvidno 

iz slike 27 (levo) in je bil 3D oblak točk rotiran okoli z in y osi.  

Težavo smo preprosto rešili z ukazom v meniju 'Modelling' -> 'Coordinate frame' ... -> 

'Reorient'. Piramide in 3D oblak točk so se zopet postavili v pravilni položaj, kot je prikazano 

na sliki 27 (desno). 

 

Slika 27: Uporaba ukaza Reorient. 
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5.2.5 Merjenje slikovnih točk  

Slikovne točke merimo v modulu 'Shot mode'. Statistične parametre izračuna objektnih točk 

lahko preverjamo zgolj grafično. Pri tem ugotovimo grobe napake identifikacije slikovnih točk, 

ki jih v takem primeru izbrišemo in ponovno zajamemo. 

 

5.2.6 Teksture 

Težave nam je povzročalo dodajanje tekstur. Samo teksturiranje modela naj bi bil preprost 

končni korak pri modeliranju. Vendar pa nismo mogli na enkrat teksturirati celotnega modela, 

pokrile so se zgolj nekatere ploskve modela, kar je razvidno iz slike 28. 

Program ne omogoča izvoza tekstur skupaj z modelom. 

 

 

Slika 28: Prikaz delno teksturiranega modela. 

 

5.2.7 Formati za izvoz in uvoz podatkov 

Ena izmed večjih pomanjkljivosti programa je majhna izbira formatov za zapis 3D podatkov. 

Program omogoča uvoz tekstovnih formatov (*.ifl oziroma *.txt), s katerim uvozimo več 
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fotografij naenkrat, ali uvoz posameznih fotografij (*.jpg, *.png). Omogočen je uvoz projekta v 

zapisu RealVIZ (*.rzml ali *.rzi) ter oblaka točk (*.txt).  

Kot najbolj uporaben format za izvoz 3D modela se je izkazal format VRML (*.vrml, *.wrl), ki 

ga uporabljamo za predstavitev 3D interaktivne vektorske grafike. Ta format nam je 

omogočal uvoz 3D modela v MeshLab, vendar pa nam je Insight3D omogočal le izvoz 

ploskev brez tekstur. Ostali formati, ki jih je mogoče izvoziti so navedeni v preglednici 4.  

Pri uporabi programa smo pogrešali možnost uporabe večjega števila različnih formatov, ki bi 

nam omogočili izvoz vseh informacij oziroma bi imeli na izbiro izvoz različnih vrst podatkov, 

ki nas zanimajo. Na primer format OBJ in U3D, ki tako kot VRML podpirata izvoz tekstur, ali 

PLY, s podatki o barvi za vsako točko 3D modela ter COLLADA z metapodatki. Dobrodošla 

bi bila tudi formata U3D in X3D, ki sta standardna formata za izmenjavo podatkov o 

računalniški grafiki oziroma predstavitev in prenos 3D-scen in objektov, ali vsesplošno 

uporabni PDF (Štuhec, 2012).  

 

5.2.8 Nestabilnost programa, nezmožnost interaktivnega vnosa podatkov 

Med uporabljanjem programa je priporočljivo, da projekt večkrat shranimo, saj se je program 

izkazal kot nestabilen. Kadar se pojavi težava, ki je ne uspe rešiti, neha delovati. Velikokrat 

se je to zgodilo pri prepoznavanju in ujemanju značilnih točk, torej v operacijah, ki uporabljajo 

več delovnega spomina računalnika. V naslednjih korakih nismo zaznali težav.  

Nestabilnost programa se je izkazala tudi pri obravnavanju večje količine podatkov, to je 

večjem številu fotografij (nad 20). Pri prepoznavanju značilnih točk smo izbrali najnižjo 

ločljivost fotografij, ampak je program potreboval veliko časa ter pred zaključkom postopka 

nehal delovati.  

Nezmožnost interaktivnega vnosa podatkov se je pokazala kot slabost predvsem pri 

prepoznavanju in ujemanju značilnih točk. V primeru napačno prepoznane značilne točke je 

ni možno ročno izločiti ali po potrebi določiti novo značilno točko, da bi s tem pripomogli k 

boljšim rezultatom postopkov. 

Zgrajen model nima pravega merila in orientacije v prostoru. Program nima funkcij, ki bi 

omogočile določitev merila in absolutne orientacije v koordinatnem sistemu, zato moramo za 

georeferenciranje modela uporabiti druga programska orodja. 
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5.2.9 Slaba navodila, neodzivnost avtorja 

Program je brezplačen, odprtokodni, s kratkimi navodili, ki so sicer razumljiva, vendar ne 

obsegajo vseh funkcij, ki jih naj bi program omogočal. Določene funkcije, ki smo jih 

preizkusili, niso delovale, o njih ni ničesar zapisano, avtor programa se ne odziva na 

vprašanja s strani uporabnikov, ravno tako ni veliko souporabnikov programa, ki bi svoja 

vprašanja in izkušnje delili na forumih. Uporabnik ni deležen nikakršne podpore. 

 

5.2.10   Občutljivost na pravilno fotografiranje 

Program se je izkazal kot zelo občutljiv na pravilno fotografiranje objekta. Težave nam je 

povzročalo grmovje na vzhodni strani objekta. Na tem mestu nismo mogli fotografirati po 

priporočilih iz navodil, kar se je pri izdelavi 3D modela pokazalo za nepremostljivo oviro. 

Objekta nismo mogli izdelati v enem projektu, temveč smo ga razdelili na sprednjo fasado ter 

ostale tri fasade. Zaradi grmovja smo vzhodno fasado fotografirali preveč od strani, kar se pri 

izdelanem 3D modelu treh fasad objekta odraža kot geometrična netočnost. Dimenzije 

izdelanega 3D modela se na tem mestu razlikujejo od dimenzij v naravi. 

 

5.3 Primerjava z drugo programsko opremo  

Na trgu je množica programskih orodij, komercialnih ali nekomercialnih, odprtokodnih, ki se 

uporabljajo na področju fotogrametrije. V tabeli 4 so predstavljene nekatere lastnosti 

najpogosteje uporabljenih programskih orodij, ki smo jih povzeli po navedenih virih. Vsem je 

skupno, da delujejo po postopku SfM.  

Pri vsakem programskem orodju je pomembno, da zajamemo fotografije po priporočilih iz 

navodil, naložimo fotografije v program, in postopamo po navodilih. 

Priporočila, ki delajo programsko opremo kupcem zanimivejšo, so sledeča: uporabniku 

prijazno programsko orodje, v veliki meri samodejna obdelava, hitra obdelava, cena, visoka 

natančnost, možnost uporabe izdelkov v drugih programskih orodjih, robustnost in stabilnost 

programa, obdelava velikih količin podatkov, podpora uporabnikom s strani avtorjev, 

možnost interaktivnega vnosa podatkov … 

V preglednici 5 so navedeni nekateri programi, ki so med uporabniki najbolj razširjeni, in 

njihove lastnosti. 
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Preglednica 5: Primeri med uporabniki najbolj razširjenih programskih orodij. 

Programsko 

orodje 

 

Delovno okolje 

 

Cena 

 

Odprtokodnost 

 

Avtor 

 

VisualSFM 
OS X, Linux, 

Windows  
 

 

/ 

 

Ne  
Changchang Wu 

 

 

ReCap 360 
  

Windows  
 

 

/ 

 

Ne 

 

Autodesk 

 

123D Catch 

iOS, Android, 

Windows 

 

/ 

 

Ne  
 

Autodesk 
 

 

PhotoScan 

Standard 

 

OS X, Linux, 

Windows 

 

179 $ , 3499 $ 

 

Ne 

 

Agisoft 

 

ARC3D 

 

OS X, Linux, 

Windows 

 

/ 

 

Da 

Katholieke 

Universiteit Leuven 

 

Insight3D 

 

Linux, Windows 

 

/ 

 

Da 

 

Lukas Mach 

 

Pix4D 

 

Windows 

Discovery /, 

Mesečno 260 €, 

Letno 2600 € 

 

Ne 

 

Pix4D SA 

  

          

Primerjava treh programskih orodij, ki so med uporabniki najbolj razširjeni: 

 PhotoScan 

Programsko orodje PhotoScan je produkt ruskega podjetja Agisoft LLC. Na tržišču sta 

osnovna in profesionalna različica, obe sta ponujeni kot komercialna produkta. Za nakup 

osnovne različice, ki jo je mogoče nadgraditi v profesionalno različico, je potrebno odšteti 

179 $, profesionalne pa 3499 $. Kupljena licenca nima časovnih omejitev, ponuja pa 12 

mesečno tehnično podporo in nadgradnjo programa. V izobraževalne namene je na voljo 

študijska verzija. 

Ta programska oprema ponuja vrsto funkcij, osnovna različica omogoča aerotriangulacijo, 

izdelavo oblaka točk, 3D modela in tekstur, profesionalna pa še nastavitve koordinatnega 

http://ccwu.me/vsfm/
http://recap360.autodesk.com/
http://www.123dapp.com/catch
http://www.agisoft.com/features/standard-edition/
http://www.agisoft.com/features/standard-edition/
http://insight3d.sourceforge.net/
http://www.pix4d.com/
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sistema, izdelava DMV in ortofota, georeferenciranje, 4D rekonstrukcijo objektov, obdelavo 

multispektralnih fotografij, vnos kode Python idr.  

Za nemoteno delovanje programa so priporočljive tri računalniška konfiguracije. Osnovna 

konfiguracija s pomnilnikom do 32 GB RAM-a, procesor Intel i7 CPU, 4 x 4 GB (16 GB) 

oziroma 4 x 8 GB (32 GB) ter grafično kartico Nvidia GeForce GTX 680 ali GeForce GTX 

780. Za še hitrejše in nemoteno delovanje je priporočljiv pomnilnik s 64 GB RAM-a (Agisoft 

PhotoScan, 2014). 

 Pix4Dmapper 

Programsko orodje Pix4Dmapper je produkt podjetja Pix4D SA iz Švice. Na voljo so štiri 

različne licence programa. Pix4D Discovery mapper je brezplačna, namenjena reklami, 

vendar ima omejitve pri izgradnji končnih izdelkov, ravno tako ne omogoča nadgradnje in 

podpore proizvajalca. Profesionalna različica je na voljo v treh različnih verzijah. V vseh je 

možna instalacija programa na dva računalnika, razlikuje pa se v višini plačila ter časovne 

veljavnosti licence. Enomesečno licenco najamemo za 260 € in omogoča podporo in 

nadgradnjo programa, enoletno različico najamemo za 2600 €, lahko pa programsko orodje 

kupimo za 6500 € ter pridobimo podporo in nadgradnjo v prvem letu.  

Izdelki, ki jih pridobimo s programom Pix4D so: georeferenciran ortomozaik, DMR, 

teksturiran 3D oblak točk, animacije skozi 3D oblak točk, možnost izračuna volumnov, 

izdelava plastnic, izdelki za Googlove aplikacije (*.kml, *.html), izračun notranjih in zunanjih 

parametrov fotoaparata, video animacije idr. (Pix4D, 2015).  

Za učinkovito in nemoteno delovanje progama je zaželena programska in strojna oprema z 

naslednjimi lastnostmi: 64bit Windows, 6-Core CPU i7, 16 GB RAM-a pomnilnika ter 

katerokoli grafično kartico proizvajalca Nvidia.  

 AutoDesk 123D Catch 

AutoDesk 123D predstavlja vrsto aplikacij, uporabnih na področju modeliranja. 

Fotogrametrična aplikacija je 123D Catch, ki generira 3D model iz fotografij, ostale, kot so 

123D Circuits, Design, Make, Meshmixe, idr, so namenjene modeliranju. 

123D Catch je brezplačna aplikacija, ki za delovanje ne potrebuje zmogljive računalniške 

opreme, saj prenesemo fotografije na AutoDeskov strežnik. Vsi algoritmi se izvajajo na 

njihovem strežniku, uporabnik dobi zgolj končni rezultat, izdelan 3D model. 
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 Primerjava vseh treh programskih orodij, glede na izkušnje uporabnikov: 

Programsko orodje 123D Catch je sposobno popolnoma samodejne obdelave podatkov. 

Uporabnik naloži fotografije na Autodeskov strežnik in jih pošlje v obdelavo. Po končani 

obdelavi, dobi obvestilo o rezultatih, to je 3D modelu, 3D oblaku točk ter podatkih o položaju 

fotoaparata, na e-mail naslov, in si jih kasneje prenese na svoj disk. Modelu zagotovi merilo 

s poznanimi dolžinami, koordinatni sistem pa določi na primer po glavnih oseh stavbe. 123D 

Catch omogoča izvozne formate, ki jih lahko uvozimo v ImageModeler, Meslab, Sketchup idr. 

(Gerke, 2012). 

123D Catch je brezplačno programsko orodje, ki dosega, na podlagi izkušenj uporabnikov, 

pri modeliranju dobre rezultate. Razlog je v postopku SfM, ki je enak kot pri programskem 

orodju Capture3D, sicer enemu izmed najdražjih programskih orodij dostopnih na trgu. 

Slabost programskega orodja 123D Catch je dejstvo, da Autodesku s tem, ko naložimo 

fotografije na njihov strežnik, omogočimo tudi pravice, do uporabe naših izdelkov. 

PhotoScan omogoča vrsto operacij, ki omogočijo izgradnjo zelo kakovostnih izdelkov. V 

programskem orodju je enostavno poravnati fotografije, teksturirati ploskve, georeferencirati 

model idr. V njegovo korist priča tudi prijaznost programa do uporabnika ter topološka 

popolnost pri izgradnji 3D modelov. PhotoScan omogoča v osnovni verziji kalibracijo 

fotoaparata, ki jo lahko s posebnim modulom nadgradimo in izboljšamo rezultate, poravnava 

fotografij je enostavna, s točkami s poznanimi koordinatam.  

PhotoScan omogoča izvoz veznih točk v Bingo (*.dat), ORIMO (*.txt), oblak točk kot XYZ 

PointCloud (*.txt), PhotoScan (*.oc3), Adobe PDF (*.pdf), model kot COLLADA (*.dae), 

Autodeskoc DXF (*.dxf), VRML model (*.wrl), teksture (*.jpg, *.tiff, *.png idr.). V PhotoScan 

pa ne moremo uvoziti veznih točk in oblaka točk, medtem ko lahko v program uvozimo ali 

izvozimo notranje in zunanje parametre fotoaparata (*.xml za PhotoScan, *.out za Bundler 

idr.) (Agisoft PhotoScan User Manual, 2014).  

Interaktivni vnos podatkov (v fazi triangulacije in izgradnje DMR) izboljša rezultate in poveča 

stabilnost programa. PhotoScan omogoča obdelavo velike količine podatkov (na primer 

izdelavo modela iz približno 600 fotografij je potreboval 18 ur (Vidmar, 2014)), ki pa 

zahtevajo dovolj zmogljivo računalniško opremo in čas. Uporabniki, v večini začetniki, imajo 

lahko težave z uporabo programa, saj je potrebno vsa pojasnila glede funkcij ukazov poiskati 

v navodilih in forumih (Agisoft PhotoScan Forum, 2015). 

Programsko orodje Pix4D ravno tako omogoča interaktiven vnos podatkov, kar poveča 

robustnost in stabilnost programa. Pix4D slovi kot uporabniku zelo prijazno programsko 

orodje, z veliko podpore avtorjev programa, kar pri drugih programih ni pravilo. Visoka cena v 
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primerjavi z ostalimi programskimi orodji in uporaba zgolj na operacijskem sistemu Windows 

vsekakor ne pričata v njegovo korist.  

Pix4D omogoča izvoz cele vrste različnih formatov, kompatibilnih z drugimi programskimi 

orodji. Tako lahko izvozimo notranje in zunanje parametre fotoaparata, oblak točk v različnih 

formatih – med pomembnejšimi so: *.las za uvoz v ArcGIS, *.xyz za v AutoCAD, *.ply za v 

MeshLab – DMR lahko izvozimo kot *.xyz in uvozimo v AutoCAD ali *.las za uvoz v ArcGIS, 

teksturirane 3D modele lahko izvozimo kot *.ply v MeshLab, ali *.pdf. Poleg tega omogoča 

izvoz cele vrste drugih izdelkov in formatov za v različna programska orodja, kot so Inpho, 

Global Mapper, Google Earth in Google Maps, Blender, Windows Media Player in drugi 

(Pix4D, 2015). 
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6 REZULTATI OBDELAVE IN PRIMERJAVA 3D FOTOGRAMETRIČNEGA MODELA 

S TERENSKIMI MERITVAMI  

 

V programu Insigh3D nam ni uspelo izdelati celotnega 3D modela senika v enem projektu. 

Objekt smo razdelili na dva dela – sprednjo (severno) fasado ter ostale tri (zahodno, južno in 

vzhodno) fasado.  

Na sliki 29 sta prikazana delno teksturirana 3D modela v programu Insight3D. Program nam 

ni omogočil izvoza tekstur 3D modelov, smo pa uspeli narediti dva topološko popolna 3D 

modela. Levo je prikazan 3D model treh fasad senika, desno pa 3D model sprednje fasade 

senika. 

 

 

Slika 29: Delno teksturirana 3D modela v programu Insight3D. 

 

Izdelanima 3D modeloma v programu Insight3D je bilo potrebno določiti še absolutni položaj 

ter pravo merilo. To smo zagotovili v programu MeshLab. 

Z detajlno polarno metodo izmere smo določili koordinate oslonilnih točk na objektu v novem 

državnem koordinatnem sistemu D96/TM. Na osnovi koordinat oslonilnih točk, ki so služile 

kot vhodni podatek v programu MeshLab, smo z orodjem Reference Scene 3D modelu 

določili položaj v novem državnem koordinatnem sistemu D96/TM in merilo. Poleg oslonilnih 

točk smo izmerili še kontrolne točke, ki so služile za izračun dolžin po enačbi (3).  

D = √∆𝑋2 + ∆𝑌2 + ∆𝑍2 

(3) 
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Na georeferenciranem 3D modelu smo v programu MeshLab izvedli meritve dolžin in jih 

primerjali z izračunanimi dolžinami iz koordinat kontrolnih točk. Na sliki 30 (a) je prikazan 

georeferenciran 3D model treh fasad objekta, na sliki 30 (b) pa georeferenciran 3D model 

sprednje fasade objekta v programu MeshLab. 

 

(a) 

(b) 

Slika 30: Prikaz 3D modela objekta v programu MeshLab. 

 

Izdelana 3D modela nismo združili. Program MeshLab namreč omogoča združitev dveh 

modelov na podlagi prekrivanja skupnih ploskev (orodje Alignment), ki pa jih v tem primeru 

nimamo. Z namenom prikaza obeh 3D modelov v enem, smo združili oba 3D modela v 

novem državnem koordinatnem sistemu D96/TM. Rezultat združitve je prikazan na sliki 31. 
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Slika 31: Georeferencirana 3D modela senika. 

 

Na sliki 31 (levo) je mogoče opaziti geometrično nepopolnost enega izmed 3D modelov. Na 

3D modelu treh fasad, natančneje na vzhodni fasadi, je prišlo do grobe napake. Že na 

pogled je videti ta fasada prekratka. V nadaljevanju bomo potrdili to ugotovitev, na podlagi 

rezultatov iz preglednice 7. 

 

6.1 Primerjava kontrolnih dolžin 

Kakovost prostorskih podatkov lahko opišemo z geometrično točnostjo, ki nam poda stopnjo 

ujemanja rezultatov meritev z dejansko32 vrednostjo. V našem primeru smo za mero 

geometrične točnosti uporabili koren srednjega kvadratnega pogreška (ang. root mean 

square error), v nadaljevanju RMSE, ki smo ga izračunali iz odstopanj kontrolnih dolžin.  

Oceno geometrične točnosti smo izvedli na osnovi primerjave fotogrametrično izdelanega 3D 

modela in geodetskih meritev objekta v naravi. Primerjali smo izračunane dolžine iz koordinat 

kontrolnih točk na objektu ter fotogrametrične meritve teh dolžin na 3D modelu. Na osnovi 

odstopanj med izmerjenimi dolžinami smo izračunali še RMSE.  

RMSE je mera za odstopanje slučajne spremenljivke od neke standardne oziroma privzete 

vrednosti. Uporabljamo ga kot mero točnosti. Enačba za RMSE je (4), kjer je xi posamezna 

vrednost slučajne spremenljivke z n členi – v našem primeru dolžina na 3D modelu, xpi pa 

standardna oziroma privzeta vrednost – v našem primeru referenčna dolžina v naravi 

(Frančula, Lapaine, 2003). 

 𝑅𝑀𝑆𝐸 =  √
𝟏

𝒏
∑ (𝒙𝒊

𝒏
𝒊=𝟏 −  𝒙𝒑𝒊)𝟐    

     (4) 
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V preglednici 6 so prikazane izračunane dolžine med kontrolnimi točkami v naravi, 

fotogrametrične meritve dolžin na 3D modelu in odstopanje med njimi ter izračunani RMSE, 

ki se nanašajo na sprednjo fasado objekta, izmerjene dolžine so prikazane na sliki 32 (a). 

 

Preglednica 6: Prikaz merjenih dolžin v naravi, na 3D modelu, odstopanje in RMSE, ki se nanašajo na 
sprednjo fasado senika. 

SENIK - sprednja fasada 

Oznaka dolžine Dolžina v naravi [m] Dolžina v modelu [m] Odstopanje [m] 

1 8,39 8,41 -0,02 

2 7,31 7,34 -0,03 

3 0,78 0,78 0,00 

4 0,77 0,71 0,06 

5 2,88 2,88 0,00 

RMSE [m]                                                                                                       0,03 

 

 

V preglednici 7 so prikazane izračunane dolžine med kontrolnimi točkami na ostalih treh 

fasadah v naravi, fotogrametrične meritve na 3D modelu in odstopanje med njimi ter RMSE, 

na sliki 32 (b) pa so prikazane izmerjene dolžine na seniku. 

 

 

Preglednica 7: Prikaz merjenih dolžin v naravi, na 3D modelu, odstopanje in RMSE, ki se nanašajo na 
tri fasade senika. 

SENIK - 3 fasade 

Oznaka dolžine Dolžina v naravi [m] Dolžina v modelu [m] Odstopanje [m] 

1 7,31 7,28 0,03 

2 8,37 8,29 0,08 

3 6,30 5,86 0,44 

4 6,30 6,30 0,00 

5 0,75 0,76 -0,01 

6 0,75 0,77 -0,02 

7 3,12 3,04 0,08 

RMSE [m]                                                                                                 0,17 

RMSE - brez 3. 
dolžine [m] 

                                                                                                0,05 
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(a) 

(b) 

 

Slika 32: Skica izmerjenih dolžin na seniku. 

 

Na podlagi rezultatov iz preglednice 6, ki se nanašajo na 3D model sprednje fasade senika, 

je razvidno, da je RMSE 0,03 m. Iz preglednice 7, kjer so podatki o ostalih treh fasadah 

senika, pa je razvidno, da je RMSE izdelanega 3D modela 0,17 m.  

Kot smo že na sliki 31 ugotovili, so nam rezultati iz preglednice 7 potrdili, da je prišlo na 

vzhodni fasadi do grobe napake. Na sliki 32 (a) je ta dolžina prikazana pod številko 3, v 

preglednici 7 pa je obarvana rdeče. Razlika med izmerjeno dolžino v naravi ter dolžino v 3D 

modelu je v ostalih primerih nekaj centimetrov, pri dolžini označeni s številko 3 pa 0,44 m. 

Prišlo je do napake pri izgradnji 3D modela. 

Ta groba napaka je posledica fotografiranja, saj se glede na ovire na terenu nismo mogli v 

celoti držati priporočil iz navodil. Na vzhodni fasadi je fotografiranje oviralo grmovje, tako da 

je bil zorni kot med dvema zaporednima fotografijama nekoliko večji, kot navadno. Ugotovili 

smo, da je imel program Insight3D težave pri prepoznavanju značilnih točk na teh dveh 

posnetkih. Kar se je kasneje pokazalo tudi pri neuspešni kalibraciji in modeliranju. S tem 
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razlogom smo tudi ločili senik na dva dela in izdelali dva 3D modela. Program je vseeno 

slabo izdelal vzhodno fasado. Tako smo izmerjeno dolžino številka 3 izločili iz nadaljnje 

obravnave. RMSE znaša po odstranitvi grobe napake 0,05 m. 

Pri modeliranju senika smo se soočali s številnimi težavami, tako da nam je zgolj delno 

uspelo izdelati 3D model v želeni četrti ravni podrobnosti LOD3 po standardu CityGML. 

Zahteve četrte ravni podrobnosti (LOD3) so detajlno prikazana zunanjost, to pomeni, da 

imajo stavbe modelirana stopnišča, dimnike, balkone, okna, zračnike idr. Glede na stopnjo 

prikazanega detajla, ki smo ga zmodelirali na izdelanem 3D modelu senika, to je 

poenostavljen objekt z dodano streho, smo zadostili zahtevam tretje ravni podrobnosti 

(LOD2).  

Glede na težave pri modeliranju senika, smo želeli izdelati še en 3D model manjšega, 

enostavnejšega objekta, ter tako še enkrat preizkusiti program Insight3D pri izdelavi manj 

kompleksnih 3D modelov. Izbrali smo si del cerkve, zakristijo, v Škocjanu.  

Pri modeliranju zakristije smo se držali vseh navodil glede fotografiranja objekta. Predvsem 

smo pazili, da je bil zorni kot med fotografijami enakomeren, ter da je imel izbran objekt čim 

več ravnin, ki se sekajo pod kotom. 

Pri izdelavi 3D modela zakristije nismo imeli težav. Program se je izkazal kot primeren za 

manjše, manj kompleksne stavbe. Na sliki 33 je prikazan teksturiran 3D model zakristije.  

 

 

Slika 33: Prikaz teksturiranega 3D modela zakristije v programu Insight3D. 

  

Izdelan 3D model v programu Insight3D nima pravega merila, niti določenega položaja v 

novem državnem koordinatnem sistemu D96/TM. Ker nas je zanimala zgolj izgradnja 3D 
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modela ter njegova geometrična točnost, smo mu merilo zagotovili v programu MeshLab. Na 

terenu smo izmerili karakteristične dolžine z merskim trakom. Na podlagi izmerjenih 

karakterističnih dolžin, ki so služile kot vhodni podatki, smo mu merilo določili z orodjem 

Scale. Na sliki 34 je prikazan 3D model v programu MeshLab. 

 

 

Slika 34: Prikaz 3D modela zakristije v programu MeshLab. 

 

Podatki, ki se nanašajo na zakristijo se nahajajo v preglednici 8. Prikazane so merjene 

dolžine z merskim trakom v naravi, fotogrametrično merjene na 3D modelu, odstopanje in 

RMSE.  

Preglednica 8: Prikaz merjenih dolžin v naravi, na 3D modelu, odstopanje in RMSE, ki se nanašajo na 
zakristijo. 

CERKEV - zakristija 

Oznaka dolžine Dolžina v naravi [m] Dolžina v modelu [m] Odstopanje [m] 

1 2,31 2,33 -0,02 

2 2,34 2,29 0,05 

3 2,90 2,88 0,02 

4 4,45 4,43 0,02 

5 0,36 0,34 0,02 

6 0,55 0,48 0,07 

7 0,50 0,46 0,04 

8 0,36 0,37 -0,01 

9 0,10 0,13 -0,03 

10 0,10 0,13 -0,03 

11 0,09 0,10 -0,01 

RMSE [m]                                                                                                              0,03 

 

Na sliki 35 so prikazane dolžine na zakristiji, ki smo jih upoštevali pri analizi. 
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Slika 35: Skica izmerjenih dolžin na zakristiji. 

 

Na podlagi rezultatov iz preglednice 8, ki se nanašajo na 3D model zakristije je razvidno, da 

je RMSE 0,03 m. 

Iz analize podatkov lahko povzamemo, da je s programom Insight3D mogoče izdelati 3D 

model v rangu natančnosti nekaj centimetrov.  

Glede na ugotovitev, da je program občutljiv na pravilno fotografiranje objekta, smo želeli 

izdelati 3D model z istimi fotografijami, kot so bile uporabljene v programu Insight3D, vendar 

drugim programskim orodjem. Izbrali smo Autodeskov 123D Catch, ker je brezplačen 

program, dostopen na svetovnem spletu. 

Izdelana 3D modela sta na sliki 36. Oba 3D modela sta topološko popolna, sorazmerna, 

izdelana v enem projektu, teksturirana itd. Iz rezultatov lahko sklepamo, da smo 

fotografiranje izbranega senika izvedli korektno, težave pri izgradnji 3D modela pa lahko 

pripišemo občutljivosti algoritmov prepoznavanje značilnih točk v programu Insight3D. 
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Slika 36: 3D modela senika in zakristije izdelana v programu 123D Catch. 
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7  ZAKLJUČEK  

Povezovanje bližnjeslikovne fotogrametrije in računalniškega vida je v zadnjem desetletju 

prevzelo vodilno vlogo pri 3D modeliranju objektov. Razvoj algoritmov na področju 

računalniškega vida, nižje cene in boljša kakovost digitalnih fotoaparatov ter algoritmi za 

kalibracijo nemerskih fotoaparatov so omogočil kakovostno modeliranje objektov na osnovi 

prekrivajočih se fotografij. Tako so velik napredek doživela programska orodja, ki omogočajo 

pridobivanje prostorskih podatkov iz niza fotografij, posnetih pod različnimi zornimi koti. Iz 

pestrega nabora programskih orodij, dostopnih na trgu, smo si za magistrsko nalogo izbrali 

program Insight3D, da bi ga preizkusili, saj nimamo praktičnih izkušenj z njim. 

Glede na cilje, ki smo si jih zastavili na začetku magistrske naloge, lahko povzamemo, da 

smo jih zgolj delno izpolnili.  

Glavni zastavljeni cilj je bil spoznati se s programom Insight3D, kar nam je v večji meri 

uspelo. Spoznali smo delovanje programa, pri tem pa se soočali z veliko težavami že pri 

samem zajemu fotografij, saj smo pri uporabi programa ugotovili, da se je potrebno v celoti 

držati priporočil glede fotografiranja, drugače nastopijo težave pri delovanju programa – tako 

smo se soočali s težavami pri postopku slikovnega ujemanja in kalibraciji. Nadalje smo imeli 

težave z orientacijo izdelanega 3D oblaka točk, izdelavo tekstur idr. Veliko težav nam je 

povzročal izvoz 3D modela, saj ima program na razpolago malo različnih formatov za izvoz 

3D modelov. Kljub izbranemu *.vrml formatu, ki je splošno uporabljen za izvoz teksturiranih 

3D modelov, pa program ni izvozil tekstur. Program se je izkazal kot nestabilen, ne omogoča 

interaktivnega vnosa podatkov, ki bi na primer pripomoglo k boljšemu prepoznavanju 

značilnih točk ali poravnavi fotografij, priložena so nepopolna navodila … 

Glede na težave nam je zgolj delno uspelo 3D model izdelati v želeni četrti ravni podrobnosti 

LOD3 po standardu CityGML. Izbranega objekta nismo sestavili v enem projektu, ampak 

smo ga izdelali v dveh korakih – posebej sprednjo (severno) fasado ter posebej ostale tri 

fasade. Razlog za neuspešno izdelavo celotnega 3D modela je v sami občutljivosti programa 

Insigh3D pri postopkih slikovnega ujemanja in kalibracije. To smo potrdili z izdelavo še 

enega 3D modela. Izbrali smo si del cerkve, zakristijo v Škocjanu in potrdili domnevo, da 

program uspešno deluje na majhnih, enostavnejših objektih, ki jih je mogoče zajeti brez ovir. 

Pri 3D modelu zakristije nam je to uspelo, saj smo izdelali geometrično točen 3D model. 

Glede na težave, s katerimi smo se soočali pri modeliranju senika, nam je uspela izdelava v 

tretji ravni podrobnosti (LOD2) po standardu CityGML. V našem primeru smo ocenili 

geometrično točnost izdelanega 3D modela v rangu nekaj centimetrov, kar je lahko za 

določene vrste aplikacij sprejemljivo. 
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Ker smo se želeli prepričati, da je bilo fotografiranje izbranega objekta senika izvedeno 

korektno, smo iz istih fotografij izdelali 3D model v drugem programskem orodju. Izbrali smo 

brezplačni Autodeskov 123D Catch, Rezultat je potrdil domnevo, da smo fotografiranje 

izvedli korektno, slabe rezultate v programu Insight3D pa lahko pripišemo občutljivosti 

algoritmov prepoznavanja značilnih točk v programu. 

Na podlagi rezultatov lahko zaključimo, da ima program Insigt3D veliko pomanjkljivosti. 

Razlog je lahko v namenu izdelave programa, saj je bil ustvarjen v sklopu diplomskega dela 

Lukasa Macha s Fakultete za matematiko in fiziko v Pragi. Pomanjkljivosti bi lahko iskali 

ravno v dejstvu, da je bil program izdelan v študijske in ne komercialne namene, kar bi 

vsekakor pomenilo odgovornost avtorjev pri podpori in nasvetih do kupcev oziroma 

uporabnikov. V neodzivnosti avtorja programa lahko sklepamo, da nima namena nadgradnje 

svojega izdelka, v odprtokodnosti programa pa vidimo priložnost v izpopolnitvi, spreminjanju 

in popravljanju kode algoritmov s strani uporabnika samega, kar bi pripomoglo k stabilnosti 

delovanja programa. 
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